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Introduction
CCWTrak is a Windows-based software application designed to help firearms instructors 
keep track of classes they conduct, students that attend those classes, submit 
paperwork to authorities on behalf of their students, identify customers who are 
delinquent in paying for classes they attend, and identify students whose certifications 
are coming due to expire. CCWTrak is designed with data integrity, ease of use, and 
flexibility to ensure that an instructor’s valuable time is spent on the range instead of 
behind the computer screen. CCWTrak includes a professional-grade report writer that 
can generate mailing labels, form letters, certification forms and any type of managerial 
report – all report output can be filtered to meet a specific reporting need.  CCWTrak is 
the only software of its kind that specifically developed to manage a firearms instructor 
needs!

System Requirements
 Windows 8 (or higher)
 All Windows applications “like” computer memory – a starting point for any Windows 

machine should really be 16GB of memory. If this application starts running slower, 
check your Windows Task Manager for applications that are leeching memory (and then 
start closing them)

 This application runs comfortably within 20MB of disc space
 A decent color monitor capable of displaying 1028x768 (or higher resolution)

Installation
This application’s “setup.exe” program displayed options of where to install this program [e.g. 
C:\Program Files (X86)]. It also created Start Menu entries for the application, its user manual, 
and an uninstallation program. An entry was also created within the Windows “Apps” start 
menu option to uninstall the application. Data file(s) that you created via this application are 
NOT deleted, and will remain on your computer until you manually delete them. 

Generally speaking, you may install newer versions of this application “on top” of itself, as our 
installation programs won’t overwrite configuration file(s) or data files that you’ve created.

CCWTrak can be installed on network share to enable access to the program and 
manage your courses/students regardless of which computer is used on your computer 
network.  Each Windows network user account needing to access CCWTrak must have 
CHANGE network permissions to the folder that CCWTrak resides within that network 
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share. CCWTrak is a network-aware Windows application, and can accommodate 
multiple users accessing its database files simultaneously.   If two (or more) users 
attempt to access the same database record at the same time, the user that opened 
that database record first will maintain ownership of that record and subsequent users 
will be denied access to that database record until it has been released.  Reports are 
generated using the workstation’s resources (i.e. CPU, memory, hard drive).

Quick Start
CCWTrak was designed to accommodate any type of firearms instruction class.  You can 
store an unlimited number of classes, each of which can have an unlimited number of 
students that participated in a class.  Each student can qualify with all three possible 
types of handguns (Derringer, Revolver and Semi-Automatic) for each class they attend.

Let’s assume you’re starting at ground zero (i.e. just installed CCWTrak onto your 
computer and want to immediately dive in and start using it to track an upcoming class. 
Here is what you would do:

1. Populate your lookup databases (aka: tables) first:
a. Main Menu -> File -> Lookup Table -> Courses You Teach
b. Main Menu -> File -> Lookup Table -> Firearm Calibers (*)
c. Main Menu -> File -> Lookup Table -> Firearm Type Codes (*)
d. Main Menu -> File -> Lookup Table -> Training Locations

(*) CCWTrak will ship with this database already pre-populated – you can 
modify its contents

2. Configure the CCWTrak application settings
a. Main Menu -> Configure Application Settings [note: when CCWTrak 

initializes it will automatically check if these settings have been 
configured or not. If at least one of the entries is blank / the file is missing 
/ the file is corrupt then this menu option is automatically executed for 
these settings to be manually entered]

3. Add the first class that you are going to teach
a. Main Menu - > Browse Classes  OR  click the toolbar button titled ‘Classes
b. The ‘Classes Taught’ browse screen is displayed onscreen
c. Click the ADD button
d. Add the pertinent information about this class (who/what/when/where) 

then click the SAVE button to save this class to the CLASS database and 
return to the ‘Classes Taught’ browse screen
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e. Double left click the desired class to display the data entry form for the 
CLASS database

f. Click the tab titled ‘STUDENTS IN THIS CLASS’
g. Click the ADD button – enter the student information that has expressed 

interest in taking this class, then click SAVE to save the data to the 
STUDENTS database [note: only the student’s first and last name are 
mandatory entries on this data entry form. At any time you can add 
additional information about each student (e.g. data required for DPS 
registration paperwork)].

h. If there are more students for this class repeat step 3G for each of them

4. Once the registration deadline for this class has been reached (or the maximum 
number of students for this class has been reached send them an email to 
provide them with blank copies of any forms that they must fill out, the training 
location date/time, directions to the training site, etc. To generate this email 
(assuming you’ve populated the student’s email address information within the 
Students data entry screen) you will

a. Main Menu - > Browse Classes  OR  click the toolbar button titled 
‘Classes’

b. The ‘Classes Taught’ browse screen is displayed onscreen
c. Double left click the desired course
d. Click the tab titled ‘STUDENTS IN THIS CLASS’
e. Click the button titled ‘Generate Email To This Class’
f. A blank email will be created using your email client software (e.g. 

Microsoft Outlook; Thunderbird) – the email addresses will be placed into 
the BCC area of the new email. You can now add the file attachments and 
type a meaningful message into the email body.

5. The class data is approaching; print a class roster for the attendees to sign
a. Main Menu - > Browse Classes  OR  click the toolbar button titled 

‘Classes’
b. Click the button titled ‘Print Report for Selected Course Only’
c. The Report Manager screen will appear
d. Select the CCW Courses report titled ‘CCW Class Roster’ by left clicking 

that entry one time
e. Execute that selected report by either double left clicking it or click the 

button titled ‘Print the Highlighted Report’
f. The report is generated for the students that are participating in that 

class and displayed within the print preview window. You can print as 
many copies as you need (e.g. print one copy for each day of instruction 
for the student to initial when entering the classroom)

6. The class/certification range time is conducted/completed. To log what each 
student qualified with (i.e. handgun type / caliber / qualification score):
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a. Main Menu - > Browse Classes  OR  click the toolbar button titled 
‘Classes’

b. The ‘Classes Taught’ browse screen is displayed onscreen
c. Double left click the desired course
d. Click the tab titled ‘STUDENTS IN THIS CLASS’
e. Select the desired student from the list of students then double left click 

their name or click the button titled ‘EDIT’ to display that student in a 
popup data entry screen

f. Enter their qualification results in the appropriate data entry fields
g. Click the SAVE button
h. Repeat steps 6e through 6g for each student that participated in the class

7. CCWTrak comes with reports prebuilt for New Mexico’s Department of Public 
Safety. If you live in another state you will need to either modify these reports to 
mimic the design of your state’s form(s) or create a new report for that 
particular form. We’re going to assume (for practicality sake) that you live in 
New Mexico or already created the desired report(s)/form(s) using the CCWTrak 
Reporting Tool. 

a. To print an initial training certificate for each student in this particular 
class

i. Main Menu - > Browse Classes  OR  click the toolbar button titled 
‘Classes’

ii. Left click the desired course
iii. Click the button titled ‘Print Report for Selected Course Only’
iv. The Report Manager screen will appear
v. Select the CCW Courses report titled ‘CCW Certificate of 

Successful Training (Initial)’ by left clicking that entry once
vi. Execute that selected report by either double left clicking it or 

click the button titled ‘Print the Highlighted Report’
vii. The report is generated for the students that are participated in 

that class and displayed within the print preview window. The 
report is designed to print each student’s certificate on its own 
page.

b. To print an After Action report for a particular class
i. Main Menu - > Browse Classes  OR  click the toolbar button titled 

‘Classes’
ii. Click the button titled ‘Print Report for Selected Course Only’

iii. The Report Manager screen will appear
iv. Select the CCW Courses report titled ‘CCW After Action Report’ by 

left clicking that entry one time
v. Execute that selected report by either double left clicking it or 

click the button titled ‘Print the Highlighted Report’
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vi. The report is generated for this class and displayed within the 
print preview window. You can print as many copies as you need 
to submit to DPS.

8. Typically you must send your state’s DPS office the report that you generated in 
step 7b.  After you’ve mailed/hand carried that report (and any other required 
documentation) you must update CCWTrak of when you completed that legal 
step:

a. Main Menu - > Browse Classes  OR  click the toolbar button titled 
‘Classes’

b. Double left click the desired course to display it’s data entry screen
c. Update the value of the data entry field titled ‘Documents Sent to DPS 

On?’
d. Click the SAVE button

9. Periodically you will most likely want to “drum up” business for students that 
previously took one of your firearms classes 

a. Main Menu - > Email Students  OR  click the toolbar button titled ‘Email 
Students’

b. Select from the popup window titled ‘Saved Queries’ the query titled 
‘Refresher Training – Due In 30 Days Or Less’

c. An email will be generated for every student whose refresher training is 
coming within 30 days of expiration or has expired

d. A blank email will be created using your email client software (e.g. 
Microsoft Outlook; Thunderbird) – the email addresses will be placed into 
the BCC area of the new email. You can now add the file attachments and 
type a meaningful message into the email body

                                                                           - OR - 

e. Main Menu - > Browse Classes  OR  click the toolbar button titled 
‘Classes’

f. Left click the desired course
g. Click the button titled ‘Print Report for Selected Course Only’
h. Select the Students report titled ‘Formletter – Refresher Training Coming 

Due’ by left clicking that entry one time
i. Execute that selected report by either double left clicking it or click the 

button titled ‘Print the Highlighted Report’
j. The report is designed to print each student’s formletter on its own page. 

You can modify the formletter to fit any desired need.
k. Place each form into its own mailing envelope for post office distribute 

(snail mail)
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10. You can determine if any students have failed to pay for their instruction several 
ways:

a. Main Menu - > Browse Students  OR  click the toolbar button titled 
‘Students’

b. Within the Saved Queries droplist select the pre-defined query titled 
‘Payment in Full Not Received’

c. Any students that are displayed onscreen have not yet paid 100% of their 
tuition yet (or you forgot to update their payment information <g>)

                                                                           - OR - 

d. Main Menu - > Report Manager  OR  click the toolbar button titled 
‘Reports’

e. Select the CCW Courses report titled ‘Financial Report’ by double left 
clicking that report

f. Press the ESCape (or click the CLOSE button) when the Saved Queries 
window appears onscreen

g. The financial report is generated to the print preview window; this report 
is sorted by Instruction Date (ascending sequence); any student that has 
not paid for their training in full will have the text “Their Account is 
DELINQUENT By” and the amount they still owe for training listed on the 
generated report.

Interface Overview
BASICS – BROWSE SCREEN
A “browse screen” is used to add / edit / delete information that is stored in the 
application’s database file(s). The screen contains a large area that displays the 
database contents in a columnar fashion (i.e. a “listbox”), with buttons to ADD, EDIT, or 
DELETE data.  Each column is comprised of the database “field”, and the rows are 
comprised of the database records. Shown below is an example listbox:
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A: The column headers. Information contained within the listbox can be sorted 
alphabetically in ascending (i.e. A, B, C, D, E, etc) sequence by clicking that column 
header once; click that same column header a seconds time to sort that column in 
descending sequence (i.e. Z, Y, X, W, V).  Depending on how the listbox is configured, 
multi-column sorting might be possible (by clicking on the first listbox column that will 
be the primary sort, and hold the CTRL key down on the keyboard and left click on the 
second column to define the secondary sort level. 

Whichever column is currently the “sort column” will determine how you search for 
information in the listbox.  For example, if the “Course Name” column is current the sort 
column, and you press the letter “H” on the keyboard, the listbox highlight bar will be 
repositioned to the first database record that starts with the letter “H”. 

B: The “listbox”, where database information is displayed in columns and rows. 

C: The “VCR” control area that uses a “VCR panel concept” to quickly move the highlight 
bar upwards/downwards within the listbox. From left to right their functionality is:

1. Go to the top of the listbox (keyboard equivalent: CTRL-HOME).
2. Go up one screen within the listbox (keyboard equivalent: Pg Up).
3. Go up one database record (keyboard equivalent: Up Arrow).
4. Search within the listbox (note: might be disabled, depending on the listbox 

configuration).
5. Go down one database record (keyboard equivalent: Down Arrow).
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6. Go down one screen within the listbox (keyboard equivalent: Pg Dn).
7. Go to the bottom of the listbox (keyboard equivalent: CTRL-END).

D: Add a new database record.

E: Change the content of the currently highlighted database record.

F: Delete the currently highlighted database record [NOTE: the record deletion is 
PERMANENT! A popup window will ask you to confirm whether you want to delete the 
record or not:

G: Display the help file entry for this screen (keyboard equivalent: F1).

H: Close this window.

Normally, the listbox will display alternating colors within listbox rows to make the 
listbox easier to read (i.e. a “greenbar” effect). 
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BASICS – DATA ENTRY SCREEN
A “data entry screen” is used to add new information or edit existing information stored 
in a database. The screen consists of boxes (aka: an “entry field”) to enter information 
that will ultimately be stored inside of the database. Entry fields are usually grouped 
together in a logical manner (e.g. a business address).  Sometimes an entry field will be 
a mandatory entry and you can’t save data if that entry field is empty. If there are a lot 
of data entry fields, tabs might be used to reduce clutter and make the data entry 
screens easier to use. To select a particular data entry field to add / edit its contents you 
either left click the mouse inside of the desired data entry field or hold down the ALT 
key on the keyboard and press the letter that is underlined inside of the text string that 
is displayed to the left of the data entry field. To move forward through the data entry 
fields press the TAB key. To move backwards through the data entry fields hold down 
the SHIFT key and press the TAB key. Text fields normally will convert lowercase words 
into Proper Case words if the CAPSLOCK keyboard key is turned off (e.g. if you type in:  
this is a sentence the text will automatically be converted to: ‘This Is A Sentence’). 
Shown below is an example data entry screen with a variety of buttons used to speed 
up data entry and / or ensure that only correct choices can be made inside its associated 
data entry field:
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A: Tabs are used in this example data entry screen to consolidate data entry fields and 
simplify onscreen clutter. To navigate through the tabs either left click the mouse on the 
desired tab or, while holding down the CTRL key, press the TAB key to shuffle forward 
through each tab. 

B: This icon signifies there is a lookup (i.e. external) database assigned to this data entry 
field. This method of ensuring database integrity allows you to add / edit /change values 
stored in the lookup database (instead of forcing you to use a pre-defined list of values). 
There are several ways of using the lookup table feature:

1. If you are already familiar with the lookup database’s content, press the first few 
letter(s) of a value stored in the lookup database – if there is a matching entry 
contained in the lookup database, that entry will be retrieved from the lookup 
database and automatically inserted in this data entry field. You can use the DEL 
key to remove characters that you typed into this data entry field to select a 
different lookup value (in case there are multiple values stored in the lookup 
database that are worded similarly). 

2. Click on the icon to display the lookup browse screen window. Locate the 
desired lookup database record displayed in its listbox and then click the SELECT 
button to close the lookup browse window and insert the selected value into the 
data entry field.

3. Hold the ALT button on the keyboard and press the Down Arrow to display the 
data lookup window to locate / select the desired lookup database record and 
insert that value into the data entry field.

C: This data entry field stores a date value that is formatted as MM/DD/YYYY. You can 
click the down arrow icon (displayed to the right of the data entry field) to display a 
popup calendar to select a date, or you can enter the date (without the ‘/’ characters) 
and press the TAB key to save the value and move to the next data entry field – the data 
entry field will automatically enter the ‘/’ character for you when you press the TAB key 
(e.g. if you enter 092207, and then press the TAB key, the date entry field will 
automatically reformat the information you entered and store / display it as 
09/22/2007).  

D: The SAVE button will first verify that any data entry fields that can’t be empty or have 
other data integrity rules applied (e.g. a date field can’t be earlier than 06/26/1998) – if 
the data integrity validation fails the data entry field that failed that validation will be 
highlighted; data will NOT be saved to the database and the data entry window will 
remain onscreen. If the validation passed the information will be saved to the database, 
the data entry window will close, and you are returned to the Browse Screen or 
depending upon the application’s design, a blank data screen will be displayed to create 
another database record.

E: Displays the help file entry for this screen (keyboard equivalent: F1).
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F: Close this window (after a popup window confirms that you really wanted to close 
this window). 

BASICS – LOOKUP TABLE
A lookup table is used to ensure database integrity by forcing data to be entered 
consistently. For example, a lookup table could contain a list of states within the United 
States (i.e. AK; AL; AZ) or a list of cities that a business sells products to (e.g. Cincinatti; 
Detroit; Houston). Data integrity is especially important for reports – if a report is 
filtered on a particular city (e.g. all products sold in Houston), but you misspelled 
Houston in the database a couple of times (e.g. Hooston; Housston), then the report 
wouldn’t contain all of the information needed to make an accurate business decision.

A lookup table also gives users the flexibility to dictate WHAT information is deemed 
valid for a data entry field instead of the software developer trying to guess what values 
are valid today / in the future (and displaying those options as a dropdown list on a data 
entry screen) – a dropdown list uses static values that require the software author to 
modify the software source code, recompile the .EXE file, and then the user must 
download/install that revised software application to benefit from the new choices.

A lookup table’s contents are accessible from the data entry screen from which it is 
accessed from. Oftentimes, the software application’s Main Menu will have a menu 
option (usually found under the “Browse” main menu item) to access the Lookup 
Table’s assigned browse screen to add / edit / delete its database contents. A “lookup 
table” window is functionally identical to a Browse Screen, with the addition of a button 
titled “SELECT” that appears when this window is requested from a data entry screen:
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BASICS – REPORTS
A report is a gathering of information stored within the software application’s database 
file(s), carefully formatted / positioned, sometimes reformatted for readability (e.g. 
combine separate database fields for a customer’s First Name and a Last Name), and 
then either displayed onscreen in a Print Preview screen or sent directly to a printer that 
is accessible to your computer.  

A report does not alter / delete any information stored within the application’s 
database file(s).

In most instances, the report is pre-designed to automatically filter information that 
doesn’t meet the requirements of the report; for example, if the report is supposed to 
print only company sales to Cincinatti, it will automatically filter out database records 
where the database field “city” doesn’t contain “Cincinatti”. The software developer is 
responsible for ensuring the database information is filtered correctly unless they have 
provided the application’s user with the ability to filter information before the report is 
generated.

Depending on the complexity of the report, the time required to generate the report 
can range from a few seconds to a few minutes (especially if the database is large; your 
computer network is operating slowly; the report-building phase is conducting a large 
number of complex mathematical calculations or reformatting database fields for 
improved readability). 



                                           Software by Daughtry | Complexity Made Simple                            Page 17

BASICS – PRINT PREVIEW SCREEN
Application reports that aren’t sent directly to a printer or to a file that is created, and 
then stored, on your computer’s hard drive are sent to a Print Preview screen which 
allows you to view the report in its entirety without printing it; selectively print page(s) 
of the report; search for information in the report and other features. Shown below is 
an example print preview screen:

A:  Primary Toolbar:  This toolbar contains the majority of features that are available in 
this Print Preview engine. From left to right each button’s functionality is:

1. Exit the print preview window; do not send the report to the printer.
2. Print the entire report; after being clicked, a popup window will appear onscreen 

that will allow you to select which printer (connected to your computer or 
available on your computer network) to send the report to. Depending on your 
printer’s capabilities, you might be able to print a range of report pages and / or 
decide on the number of copies of the report to print.

3. Print only the currently displayed report page only. Depending on your printer’s 
capabilities, you might be able to print a range of report pages and / or decide 
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on the number of copies of the report to print.
4. Send all pages of the report to an Adobe Acrobat *.PDF file.

a. Note 1: You do NOT need Adobe Acrobat Professional (or any other PDF 
generation printer driver) installed to use this feature. This application 
includes the ability to generate a *.PDF file.

b. Note 2: The *.PDF file builds a unique temporary filename to ensure it 
doesn’t overwrite an existing file.

c. Note 3: The *PDF file is generated to the Windows Desktop used by the 
active Windows user account.

d. Note 4: After the *.PDF file has been created a popup window will 
appear:
     

5. VCR control button to display the first page of the report.
6. VCR control button to display the previous page of the report.
7. VCR control button to display the next page of the report.
8. VCR control button to display the last page of the report.
9. An entry field to type in the page number of the report that you want to display 

onscreen. Alternatively, you can use the spin box (displayed immediately to the 
right of the data entry field) to move upwards or downloads within the report.

10. Display the report page in FULL WIDTH mode (horizontally fill the screen).
11. Display the report page in FULL HEIGHT mode (vertically fill the screen).
12. Display the report page with 100% zoom.
13. Toggle the PageList sidebar (C) on or off.

B:  Secondary Toolbar: This toolbar contains options for page selection / text search 
within the print preview screen. From left to right each button’s functionality is:

1. Enter a range of pages (e.g. 2-5) or individual pages separated by commas 
(1,4,5,6,9) to print in this data entry field.

2. Type in a word in this data entry field to search for text that is contained with a 
report page and then click the small magnifying glass button displayed to the 
right of the data entry field.

3. An entry field to type the number of copies of the report to print (or use the 
spinbox displayed at the right of the data entry field to increase or decrease the 
data entry field’s value).
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C: Pages Sidebar: The sidebar displayed at the left of the Print Preview screen displays a 
list of all of the pages of the report. By default, all of the pages of the report that are 
displayed onscreen are selected for printing.  To unselect a page for printing, double left 
click the green checkmark – the green checkmark is changed into a red colored “X”; to 
re-select that page to print double left click the red colored “X” to select that page to 
print (and the red “X” reverts back to the green colored checkmark). 

D: Report Preview Area: This area contains the actual generated report and can be 
scrolled left/right and upwards/downwards. Right clicking the mouse inside this area 
will shrink the report page; left clicking the mouse inside this area will enlargen the 
report page.

BASICS – MAIN SCREEN

The application’s “main screen” is your interface to everything this software application 
can do. All application “sub” windows reside “inside” of the “main screen.  This 
application’s main screen looks like this:

A:  These three buttons are found in nearly every Windows application; from left to 
right their functionality is:
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1. Minimize this application to the Windows taskbar.
2. Toggle the Main Screen of this application from full screen to a portion of the 

screen.
3. Close this application

B: This is the application’s main menu. You can select a main menu option by left 
clicking the mouse on one of the main menu’s words (e.g. File; Edit; Window) or by 
holding down the ALT button on the keyboard and then press the underlined word of 
the desired main menu option (e.g. ALT-F). Once the main menu option has been 
selected and displayed, you can use the arrow keys on the keyboard to navigate, and 
then select using the Enter key, a main menu’s different options.

C:  This is a toolbar that duplicates some of the most commonly used application’s main 
menu options.

The application’s Main Screen can be resized to any desired size by placing the mouse 
cursor at one of the window’s four corner; the mouse cursor will change from a pointer 
to a double arrow (note: if you have customized your Windows theme the mouse cursor 
might be something different in appearance; regardless, the mouse cursor will change 
shape) – while holding down the left mouse button, you will drag the window in the 
desired direction to resize the application’s window – once the application’s window is 
the desired size release the left mouse button to lock that screen size into place.

BASICS – QUERY BY EXAMPLE (aka: Filter)

Often times when you don’t want everything stored within a database to be displayed 
onscreen or printed within a report – instead, you want to display only the portion of 
the information that is important to you (i.e. a subset of data). In the computer world, 
retrieving / displaying / printing a subset of data is called “Query by Example” or QBE – 
in layman’s terms, QBE could be called “filtering”. Queries/filters are a convenient way 
of “hiding” information – the information is still stored in the database file(s) where it is 
kept, but it’s not displayed. 
 
A telephone book is a useful example of QBE – the entire book is considered to be a 
database of information that is broken into alphabetically divided sections. You use your 
eyes and fingers to execute a QBE filter by navigating to a desired section (e.g. the first 
page where names start with the letter “R”) - the non-essential information (i.e. names 
starting with A-Q) is hidden from view, thus enabling you to quickly scan for the desired 
name that begins with the letter “R”.. 
 
This software application uses an intuitive "Windows Wizard" approach to 
building/executing QBE filters. A “Windows Wizard” a type of user interface that 
presents the user (aka: YOU) with a sequence of popup windows to hand-hold you 
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through a series of well-defined steps to complete a task (in this case, that task is to 
build a QBE filter). Throughout the wizard process you can freely move backwards and 
forwards through the popup windows to shape the resulting QBE filter. 
 
Within this software application a QBE filter CANNOT, and WILL NOT, change or delete 
the contents of ANY data that is stored in a database! A QBE filter is used only to 
temporarily ‘hide” data from being displayed onscreen or printed on a report’s page. 
 
That bears repeating – A QBE FILTER USED IN THIS SOFTWARE APPLICATION WILL NOT 

DELETE OR CHANGE STORED DATA!
 
Not only does this software application use one of the most intuitive QBE interfaces 
available, but the QBE Wizard can 

 Build queries that you can save for re-use. For example, if you learn how to build 
QBE filters you can proactively build QBE filters for all possible data 
viewing/printing scenarios – less computer-savvy users can immediately use the 
saved QBE filter

 You can use the QBE Wizard interface to load an existing QBE filter, tweak it, and 
save it to a new QBE filter

 In most cases, QBE filters are reusable between that database file’s Browse 
Window and its associated reports

 A query can be as simple (e.g. Country=’France’) or as complex (e.g. 
Country=’France’ AND Visit Start Date >= '02/14/03' AND Location Visited = 
‘Canada’) as your database filtering needs require – and the QBE Wizard 
interface will help guide you through the process

 
REMEMBER: Experimenting with a QBE filter will NEVER harm your database!

BASICS – QUERY BY EXAMPLE (QBE WIZARD)
[Note: screen captures used in this section may not resemble those in this 

application; however, the concept of operation is the same]
The QBE Wizard is comprised of a series of popup windows that always display buttons 
titled BACK and NEXT (to guide you forwards and backwards through the wizard 
process). The QBE process is broken into three basic steps:
 

1. What database field will be used to limit how information is displayed onscreen / 
printed on a report page?

2. What operator will be used to determine how that selected database field is 
manipulated?

3. What value is that selected database field going to be compared against?
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For example, the three steps described above, in English terms, could be described like 
this:
 

Show only those Last Names that Start With the letter “R”
 
The example shown below shows the QBE Filter wizard “in action” to build a query filter 
where a person is visiting from CANADA: 

Step 1: Field Selection
 

 
The ‘Fields to Evaluate’ for this QBE Filter is titled 'Country the visitor claims to be 
living'; after it has been selected the NEXT button is clicked to continue the QBE Wizard 
process.
 
Step 2: Operation Selection
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As shown above, the QBE wizard module is asking how the selected field (“Country the 
visitor claims to be living”) will be evaluated. Some of the operation choices are used 
only for database fields that contain only number values (Is Greater Than, Is Less Than, 
Is Greater Than Or Equal To, Is Less Than Or Equal To) while others are used for 
database fields that contain text (Begins With, Contains, Does NOT Begin With, Does 
NOT Contain). Some Operation options work with either numbers or text (Is Equal To, Is 
NOT Equal To).
 
For this example, the option 'Begins With' was selected and the NEXT button was then 
clicked to continue the QBE Wizard process.
 
Step 3: Value Entry (For Operation)
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The entry field above stores the value that the chosen database field (Country the 
visitor claims to be living) will be compared against. The default radio button titled 
'Constant Value' will be used in this example; the other options 'Another Field' and 
'Expression' allow for more complex queries to be created. The checkbox titled 
'Compare Using Case Sensitive Matching' will be left unchecked to enable the text string 
being searched to be converted to uppercase and the search text string to also be 
uppercase - otherwise, the case that the information is entered in the database would 
have to be a perfect uppercase/lowercase match for the text entered in the data entry 
field to be matched (and the query to be successful).
 
For this example, the text 'Canada' was entered into the data entry field, and then the 
NEXT button was clicked.
 
Step 4: Query Overview

 
The window above serves two purposes:

1. Shows what the current query is
2. Allows you to continue building a more complex query by using the AND/OR 

Query Conditional Operators
 
Conditional Operators are used to string together several 'query conditions' into one 
large query. For example, if the desired query is to pull only those visitors from Canada, 
and visited ACME, you would have to use a Conditional Operator to achieve this means. 
The sample query would resemble:
 

Country Begins With Canada AND Location Visited Equals ACME
 
Conditional Operators can become a little tricky, as they work differently. Looking at the 
boldfaced query above, there are two components to the query:
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1. Country Begins With Canada
2. Location Visited Equals ACME

 
Each component of the query will return a value of TRUE or FALSE when evaluated. The 
Conditional Operators decide how each side of the query is evaluated, and decides if a 
database record met the query condition or not. The difference between the two 
Conditional Operators is:
 

 AND - Both sides of the query condition must return a value of TRUE for that 
database record to be 'flagged' by the query

 OR - Either side of the query condition must return a value of TRUE for that 
database record to be 'flagged' by the query

 
To elaborate a little further on Conditional Operators, pretend the Visitor database has 
three database entries:
 

1. Database Record 1
Visitor Name = Alfred E. Neuman from Canada visiting ACME
 
2. Database Record 2
Visitor Name = Bugs Bunny from Canada visiting JOE-BOB INC
 
3. Database Record 3
Visitor Name = Spuds McKenzie from Brazil visiting ACME

 
The query (Country Begins With Canada AND Location Visited Equals ACME) would only 
flag database record number 1, since the second database record shows that person 
(Bugs Bunny) is visiting JOE-BOB INC; the second part of the query would return a value 
of FALSE.
 
The query (Country Begins With Canada OR Location Visited Equals ACME) would flag all 
three database records, since each has at least one portion of the query that could 
return a value of TRUE.
 
It may take some experimentation on your part to tweak the Query to return the 
desired end result. For this example, this query is complete, so the FINISH button is 
clicked.
 
Step 5: Save The Query?
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The QBE wizard is providing the opportunity to save the newly built/edited query to the 
Query database. If the NO button is clicked, the query is applied to the Browse or Report 
and then discarded. For this example the YES button is clicked.
 
Step 6: Saving the Query for Re-use

Enter a meaningful QBE filter description in the provided space. Click the OK button 
when completed. 

BASICS – QUERY BY EXAMPLE (QBE INTERFACE TYPES)
[Note: screen captures used in this section may not resemble those in this 

application; however, the concept of operation will remain the same]
You will encounter the QBE module in two areas of this software application:
 

1. A Browse Window – the QBE is used to “hide” information from being displayed 
within the listbox control

2. Before a report is generated to the Print Preview screen – the QBE is displayed 
onscreen to enable the report’s output to contain either all, or a subset of, the 
database that the report is generated from

 
The Browse Window QBE INTERFACE uses an intuitive interface to retrieve a saved 
query (via the droplist control) and the ability to modify an existing query or delete a 
query from the query database. This interface is displayed directly underneath the 
listbox:
 

 
When the droplist ‘down arrow’ is clicked with the mouse a list of all saved queries that 
have been created for that database is displayed onscreen:
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At the top of the query list is the option titled ‘All Records’ – if selected from the query 
list any active query is cancelled and all database records are displayed within the 
listbox. The second item within the query list is the option titled ‘Custom Query…’ if 
selected, the QBE Wizard will be displayed onscreen to build a new query. 
 
As displayed in the above screen capture, a substantial number of queries have been 
built for this listbox. If any of the picklist entries (except for the entries titled ‘All 
Records’ or ‘Custom Query…’ are selected that query will be activated and the listbox 
content will be limited to only those database records that match that query condition.
 
To modify an existing query you first select / activate an existing query – ideally, that 
existing query is similar to how you want the new query condition to temporarily ‘hide’ 
the listbox data. Once a query has been selected the buttons titled ‘Change’ and 
‘Delete’ become active – click the button titled ‘Change’ to then display the Query 
Wizard screen that will already have that existing query condition populated within the 
Query Wizard – you can then add to / modify the query to satisfy the filter need. 
Whenever an existing query is modified via the Query Wizard, options to either save 
that modified query using the original query’s name or save the modified query to a 
new query will be presented onscreen for your decision:
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The Report QBE INTERFACE uses a different interface than the Browse Window QBE 
Interface – the primary reason being that when a report is selected for generation to the 
Print Preview screen there is no existing window to select an existing query from a 
droplist – instead, a new popup dialogue window is displayed onscreen to decide 
whether a query will be applied to the report (to limit the printed report’s output to 
only a subset of the data) or include all database records within the report. The dialogue 
window:

a) Create a new query using the QBE Wizard
b) Clone the highlighted query – a popup window will ask for the new query’s name
c) Modify the highlighted query via the QBE Wizard
d) Rename the highlighted query via a popup window
e) Delete the highlighted query from the query database
f) Select (aka: execute) the highlighted query; the report’s output will have the 

filter activated to limit information displayed within the report to the query’s 
specifications

g) Close this window and then execute the report – all database records will be 
printed 
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BASICS – QUERY BY EXAMPLE (QBE EXPRESSION TYPE)

[Note: screen captures used in this section may not resemble those in this 
application; however, the concept of operation will remain the same]

'Expression Mode' enables you to build more complex queries with a 'helping hand' to 
guide you through the process. To access the Expression Builder the process starts out 
the same as building a simple query - first you select the database field that you want to 
build the query against and then click NEXT:
 

 
and then the OPERATOR is chosen and the NEXT button is clicked:
 

 
Be default the radio button 'Constant Value' is selected; click the 'Expression' radio 
button, which will display a clickable box next to the data entry field:
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Once the box is clicked the Expression Builder is displayed onscreen:
 

 
The box displayed at the top of the window is actually a data entry field that you can 
manually enter the query string; it will also store the query expression as you select 
items listed under the 'Data and function categories' and 'Data and function names' 
listboxes. Displayed underneath the data entry field is a row of clickable buttons for 
each possible OPERATOR. On the far right of the window are clickable buttons that 
clearly indicate their purpose by how they are labeled - the most important button 
being the 'Validate' button - when clicked, the query expression is checked to ensure a 
legitimate query expression has been created.
 
When a selection is clicked on the left listbox (e.g. Text Functions), the right listbox will 
display legitimate choices for that item.  By default, the 'Application Data' entry is 
selected in the left listbox, which displays every database field in the application in the 
right listbox.
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To build the query expression, you use a combination of the 'Application Data' choices 
with one, or more, of the available functions by clicking the mouse on the desired 
item(s). As the query expression is being built, periodically click the 'Validate' button to 
minimize troubleshooting an incorrect query expression. After the query expression is 
built, click the 'OK' button to close the Query Builder window and insert the completed 
query expression into the query wizard.
 
Depicted below is a completed query string that was built using typed text and clicking 
Expression Builder buttons that compares a stored value (DOC:DocDate) against the 
computer's current date (returned from the Today() function) minus 366 days - this 
query would return only those database records where the value stored in the 
DOC:DocDate field is older than one year from the current date:
 

 
After the query expression is built the 'OK' button is clicked to return to the Query 
Builder; the Query Expression is automatically inserted into the Query Wizard window:
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BASICS – QUERY BY EXAMPLE (QBE FUNCTIONS)

The Query Wizard has additional functionality/power embedded within it - not only can 
you compare the content of a database field against a static value (e.g. Doc:State = 
'NM'), but you can use "functions" to manipulate the data (or manipulate what the data 
is being compared against).
 
Here is a comprehensive list of functions that can be used to build a query:
 
Date & Time Functions

 AGE(birthdate [,base date]); returns a string containing the time elapsed 
between two dates

o Calculate an employee's current age based upon their stored birthday 
(DOC: Birthdate)

o AGE( DOC:Birthdate, TODAY() ) 
 CLOCK(); returns the time of day from the operating system time in standard 

time.
 DATE(month,day,year); returns a standard date for a given month, day, and 

year.
 DAY(date); computes the day of the month (1 to 31) for a given standard date.

o Return the numeric day of the month for a stored date (DOC:HIREDATE)
o DAY(DOC:HIREDATE)

 MONTH(date); returns the month of the year (1 to 12) for a given standard date.
o Determine if the stored date (DOC:TransactionDate) occurred in July
o MONTH( DOC:TransactionDate ) = 7
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 TODAY( ); returns the operating system date as a standard date.
o Determine if a stored field value (DOC:TransmitDate) is older than 30 

days old from the current date
o TODAY() - DOC:TransmitDate > 30

 YEAR(date); returns a four digit number for the year of a standard date (1801 to 
9999).

o Determine if a stored field value (DOC:TransactionDate) is older than 
2000

o YEAR( DOC:TransactionDate ) < 2001
 
Math/Trig Functions

 ABS(expression); returns the absolute value of an expression. The absolute value 
of a number is always positive (or zero).

 ACOS(expression); returns the inverse cosine.
 ASIN(expression); returns the inverse sine.
 ATAN(expression); returns the inverse tangent. 
 COS(radians); returns the cosine of a numeric expression.
 INT(expression); returns the integer portion of a numeric expression. No 

rounding is performed, and the sign remains unchanged.
 LOG10(expression); returns the base 10 logarithm of a numeric expression. 
 LOGE(expression); returns the natural logarithm of a numeric expression.
 ROUND(expression,order); returns the value of an expression rounded to a 

power of ten.
 SIN(radians); returns the trigonometric sine of an angle measured in radians. 
 SQRT(expression); returns the square root of the expression.
 TAN(radians); returns the trigonometric tangent of an angle measured in 

radians.
 
Other Functions

 CHOOSE( condition, [true value, false value] ); evaluates the expression or 
condition and returns the appropriate value parameter. If the expression 
resolves to a positive integer, that integer selects the corresponding value 
parameter for the CHOOSE procedure to return. If the expression evaluates to an 
out-of-range integer, then CHOOSE returns the last value parameter

 CHR(code); returns the ANSI character represented by the ASCII character code 
parameter.

 INLIST(searchstring,liststring,liststring [,liststring...]); returns item in a list.
o Determine if a stored value (DOC:ZIPCODE) contains one of several 

possible values
o INLIST( DOC:ZIPCODE, '87105', '87113', '87121' ) > 0

 INRANGE( expression, low, high ); returns TRUE if the value of the expression is 
within the low/high range.
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o Determine if a stored value (DOC:PRESSURE) is between a numeric range
o CHOOSE( INRANGE( DOC:PRESSURE, 30, 35) = 1, 'Tire Pressure OK', 

'Check Tire Pressure')
 INSTRING( substring,string [,step] [,start] ); returns the step number on which 

the substring was found in the string.
o Check if the word 'Carpenter' exists within a notes field (DOC:NOTES)
o CHOOSE( INSTRING(DOC:NOTES, 'Carpenter') > 0), 'Text Found', 'Text 

Absent')
 NULL(field); returns a non-zero value (true) if the field is null, and zero (false) if 

the field contains any known value (including blank or zero). 
 RANDOM(low,high); returns a random integer between the low and high values.
 VAL(character);  returns the ASCII code of a character.

 
Text Functions

 ALL(string [,length]); returns a string containing repetitions of the character 
sequence string.

 CENTER(string [,length]); first removes leading and trailing spaces from a string, 
then pads it with leading and trailing spaces to center it within the length, and 
returns a centered string

 CLIP(string); removes trailing spaces from a string.
o Combine last and first names that are stored (DOC:FNAME and 

DOC:LNAME), separated with a comma
o clip(DOC:LNAME) & ', ' & clip(DOC:FNAME)

 DEFORMAT(string [,picture]); removes formatting characters from a numeric 
string, returning only the numbers contained in the string. 

 FORMAT(value,picture); returns a numeric string formatted according to the 
picture parameter.

o Format a stored date value (DOC:HireDate) from 01/01/2010 to month, 
day year

o FORMAT(DOC:HireDate, @D4)
 ISALPHA( string ); returns TRUE if the string passed to it is alphabetic (an upper 

or lower case letter) and false otherwise.
 ISLOWER( string );  returns TRUE if the string passed to it is a lower case letter 

and false otherwise. 
 ISUPPER( string ); returns TRUE if the string passed to it is an upper case letter 

and false otherwise.
 LEFT(string [,length]); returns a left justified string. Leading spaces are removed 

from the string. Spaces are padded on the right to return a string of the "length" 
specied. To remove trailing spaces use the combination of two functions: CLIP()  
and LEFT()

o Remove leading and trailing spaces from a stored field value 
(DOC:GENDER)
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o CLIP(LEFT(DOC:GENDER))
 LEN(string); returns the length of a string.

o Take action if a stored field value (DOC:PHONE) is empty but you want 
something to print anyway on the report

o CHOOSE(  LEN(CLIP(DOC:PHONE)) = 0, 'No Phone #', DOC:PHONE)
 LOWER(string); returns a string with all letters converted to lower case.

o Convert a stored field value (DOC:SALUTATION) to lowercase
o LOWER(DOC:SALUTATION)

 MATCH( first, second [, mode ] ); returns true as to whether the first and second 
parameters match.

 NUMERIC(string);  returns the value 1 (true) if the string only contains a valid 
numeric value. It returns zero (false) if the string contains any non-numeric 
characters. 

 RIGHT( string, length ); extract text from a string from right to left.
o Determine if a stored value (DOC:ZIPCODE) ends with '121'
o RIGHT(DOC:ZIPCODE,3) = '121'

 SUB(string,position,length); returns a portion of a string.
o Determine if a stored value (DOC:ZIPCODE) starts with '871'
o SUB(DOC:ZIPCODE, 1, 3) = '871'

 UPPER(string); Returns all upper case string.
o Oftentimes you can't trust that data stored in a database is entered in 

the same case (upper, lower, mixed) - if you convert the text being 
searched to all upper case, and the search string is also uppercase, you 
will be guaranteed a match if one exists. For example, DOC:CITY contains 
differening case variations of the text string 'Albuquerque'. To guarantee 
the query will work regardless of how the city was typed you need to 
enter the query string like this:

o UPPER(DOC:CITY) = 'ALBUQUERQUE'

BASICS – QUERY BY EXAMPLE (QBE PICTURE STATEMENTS)

Date Picture Parameters
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Pattern Picture Parameters

Time Picture Parameters
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BROWSE CLASSES TAUGHT DATABASE

This browse screen uses the principles that are described in the “Basics – Browse 
Screen” portion of this help file / user’s manual:

This screen is your primary interface to manage the firearms classes you teach and to 
add student(s) for each class. 

This screen allows you to:
 Add a new class and save that information to it’s database.
 Edit an existing class already saved to the class database
 Permanently delete a class from the class database.
 Print a report from the Report Manager that is automatically filtered for just the 

class that is currently highlighted within the listbox.
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FORM – CLASSES TAUGHT
This data entry form uses the principles that are described in the “Basics – Data Entry 
Screen” portion of this help file / user’s manual. This data entry screen uses two tabs to 
segregate data into more manageable groups and is used to add / edit information 
stored inside of the database:

Tab 1 pertains to the firearms class that you have created to provide to potential 
customers. There are two groupings of information displayed on this screen:

 Group 1 (Class Overview)
o The Course Name data entry field uses a data lookup table - don’t forget 

that lookup tables use the up/down arrow keys to cycle through lookup 
table values; start typing a known lookup table value to auto-populate 
the rest of the lookup table value, or press Alt-DownArrow to 
add/edit/delete lookup table information

o If the Price Per Student amount does not have cents (e.g. $99 versus 
$99.95) you don’t have to add the ‘.00’ – simply type in ‘99’ and press the 
enter key and CCWtrak will format it with a leading dollar sign symbol 
and the ‘.00’ automatically!
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o Start Date / End Date / Documents Sent To DPS On date entry fields - you 
can use the Windows popup calendar to select a date value by clicking 
the down arrow displayed to the far right of the data entry field or 
manually type in the date value 

 Group 2 (Class Notes)
o Enter free-form text in this field about this class. For example, you can 

store the contents of an email that you want to send to the class in this 
space.

Tab 2 (Students in This Class) of this data entry screen is the workspace used to add 
student(s) to the class that was defined on tab 1. You can have an unlimited number of 
students for a single class. Once you’ve added a student to a class (via this screen) you 
can edit that student’s information an unlimited number of times. 

 Click the ADD button (far right) to add a new student to this class
 Click the EDIT button (far right) to modify the student’s information (e.g. update 

their payment information; enter their firearm qualification score and type of 
firearm used for qualification)

 Click the DELETE button (far right) to permanently remove this student from this 
class. A popup message will ask you to confirm the deletion of this student from 
the STUDENTS database
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 Click the ‘Generate Email To This Class’ to send every email address for every 
student assigned to this class to a new email (via Outlook, Thunderbird, etc) – 
the email addresses will be sent to the Blind Carbon Copy (BCC) line of the new 
email

IMPORTANT NOTE ABOUT ‘PHANTOM’ STUDENT DATABASE RECORDS

When you add a new database record entry to the class database the ‘Link2Child’ 
database field has a unique number assigned to it. When you add student(s) to the 
student database for that selected firearms class the ‘Link2Parent’ database field within 
the student database will have the associated class database’s Link2Child database field 
value assigned to it (to link each student to that specific firearms class). This is called a 
‘1-to-many relation’ (where you have 1 firearms class with many related students). Each 
student that you add to the student database is automatically saved to the student 
database (because you must click the SAVE button after entering the student’s 
information in the Student’s data entry screen). 

So far, so good.

However, if you failed to click the SAVE button displayed on the class data entry screen 
(e.g. you clicked the CANCEL button or pressed the ESCape key and answered ‘Yes’ to 
not save the class information) AFTER you added student(s) for that class then you will 
have created ‘phantom students’ that are temporarily not assigned to a firearms class. 
The next time you add a new firearms class (which will recreate the same Link2Child 
value in the class database), click the ‘Student’s In This Class’ tab, those ‘phantom 
students’ will already be populated! If those phantom students will be taking that same 
new firearms class that you’ve scheduled then you don’t have to do anything – those 
three students ‘belong’ to that new class and everything is OK. However, if these three 
students are NOT the same students who will be taking the new firearms class then the 
“fix” is to delete those three phantom student database records. Easy!

Here is a four screen depiction of what is described above (because screen captures 
speak louder than words alone <g>):
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There are two ways of not creating a ‘phantom student’ situation:

1. When you create a new firearms training class don’t add the student(s) that have 
registered for the class click the SAVE button to return back to the class 
database’s browse screen. Locate, then double left click, that newly added 
firearms class from within the listbox and THEN add the student(s) information 
for that class.

2. If you create a new firearms training class, don’t click the SAVE button (to save 
that new class’ information to the class database), add student(s) to the newly 
added course, you MUST make sure you click the SAVE button displayed on the 
class database’s data entry form – again, if you fail to click that button (to write 
the firearms class information to its database) then you will create ‘phantom 
students’  
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BROWSE STUDENTS INSTRUCTED DATABASE 
This browse screen uses the principles that are described in the “Basics – Browse 
Screen” portion of this help file / user’s manual:

This screen displays all students that have ever enrolled in a firearms class that you’ve 
taught – you can edit each student’s personal information via this screen, but you 
cannot add a student to a course from this screen (to perform that task you must use 
the class database’s browse screen). 

This screen allows you to:
 Edit an existing student database entry.
 Permanently delete a student database record.
 Send an email to the student that  is currently highlighted within the listbox.

FORM – STUDENTS 
This data entry form uses the principles that are described in the “Basics – Data Entry 
Screen” portion of this help file / user’s manual. This data entry screen uses two tabs to 
segregate data into more manageable groups and is used to add / edit information 
stored inside of the database:
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 Group 1 (Student Information): Groups the student’s personal information 
required for DPS paperwork 

o Birth Date field: you can use the Windows popup calendar to select a 
date value by clicking the down arrow displayed to the far right within 
the data entry field or type in the date value yourself

o Zip Code field: there is sufficient space in the zip code entry field for the 
Zip+4

 Group 2 (Student Information): Firearm(s) this student used for qualification 
o Don’t forget that the Gun Type and Gun Caliber data entry fields use 

lookup tables! You can use the up/down arrow keys to cycle through 
lookup table values, start typing a known lookup table value to auto-
populate the rest of the lookup tabel value, or press Alt-DownArrow to 
add/edit/delete lookup table information via a popup window

 Group 3 (Firearm Information): How the student paid for the course  
o If the payment amount charged does not have cents (e.g. $149 versus 

$149.95) you don’t have to add the ‘.00’ – simply type in ‘149’ and press 
the enter key and CCWtrak will format it with a leading dollar sign symbol 
and the ‘.00’ automatically!

o The date field displayed here functionally works identically to the one 
above
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The second tab is used to store freeform notes for this specific student. 
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BROWSE FIREARMS COURSE LOOKUP DATABASE 

This screen uses the principles that are described in the “Basics – Lookup Table” portion 
of this help file / user’s manual:

This browse screen serves two primary functions:

1. Add/edit/delete information that is stored in a dedicated database for firearm 
classes that you teach. 

2. Ensure data integrity is maintained – the primary purpose of a lookup table is to 
ensure that information is stored the same way every single time. For this 
application, it is extremely important that the following information is 
consistent:

a. The course name is spelled the same every time
b. The number of months that elapses until the student is required (usually 

by the state they reside in) to obtain refresher training is defined

When you access a lookup database browse screen from a data entry screen, a button 
titled “Select” will be displayed directly underneath this listbox. When clicked, whatever 
listbox entry is currently highlighted will have a value from that lookup table’s database 
automatically inserted into the appropriate data entry field.

This screen is also the mechanism to recalculate training refresher dates within the class 
and student databases.  For example, if DPS decides that everyone that completes the 



                                           Software by Daughtry | Complexity Made Simple                            Page 46

Concealed Carry (Initial) training must obtain refresher training every 36 months 
(instead of 48 months), you would:

1. Locate the affected class in this listbox, double left click that entry to display it’s 
data entry screen

2. Change the value for the “# Months” data entry field, then click the SAVE button 
on that data entry screen

3. Click the button titled ‘Update Training Refresher Dates In The Course/Student 
Databases For The Highlighted Course’. Once clicked, two separate processes are 
executed “behind the scenes”

a. The # of months until refresher training is due + the name of the course 
are placed into memory from the lookup table

b. The class database is looped through – every class you’ve saved with that 
exact course name will have its training refresher due date recalculated 
and then saved back to the class database

c. The STUDENTS database is looped through – every student who attended 
a class with that same name will have their training refresher due date 
recalculated and then saved back to the STUDENTS database

FORM – FIREARMS COURSE LOOKUP 
This data entry form uses the principles that are described in the “Basics – Data Entry 
Screen” portion of this help file / user’s manual. 

This data entry screen is used to add new data /edit existing data for the CLASSES.TPS 
database file. 

BROWSE CALIBER LOOKUP DATABASE
This screen uses the principles that are described in the “Basics – Lookup Table” portion 
of this help file / user’s manual:
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This browse screen serves two primary functions:

1. Add/edit/delete information that is stored in a dedicated database for the 
handgun calibers that student(s) can qualify with. 

2. Ensure data integrity is maintained – the primary purpose of a lookup table is to 
ensure that information is stored the same way every single time. For this 
application, it is extremely important that the qualification caliber is correct for 
the DPS documentation that must be filed by you and your student(s).

When you access a lookup database browse screen from a data entry screen, a button 
titled “Select” will be displayed directly underneath this listbox. When clicked, whatever 
listbox entry is currently highlighted will have a value from that lookup table’s database 
automatically inserted into the appropriate data entry field.

FORM – CALIBER LOOKUP
This data entry form uses the principles that are described in the “Basics – Data Entry 
Screen” portion of this help file / user’s manual. 
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This data entry screen is used to add new data /edit existing data for the CALIBERS.TPS 
database file. 

BROWSE HANDGUN TYPE LOOKUP DATABASE
This screen uses the principles that are described in the “Basics – Lookup Table” portion 
of this help file / user’s manual:

This browse screen serves two primary functions:

1. Add/edit/delete information that is stored in a dedicated database for the types 
of handguns that student(s) can qualify with. 

2. Ensure data integrity is maintained – the primary purpose of a lookup table is to 
ensure that information is stored the same way every single time. For this 
application, it is extremely important that the handgun type is correct for the 
DPS documentation that has to be filed by you and your student(s).

When you access a lookup database browse screen from a data entry screen, a button 
titled “Select” will be displayed directly underneath this listbox. When clicked, whatever 
listbox entry is currently highlighted will have a value from that lookup table’s database 
automatically inserted into the appropriate data entry field.

FORM – HANDGUN TYPE LOOKUP
This data entry form uses the principles that are described in the “Basics – Data Entry 
Screen” portion of this help file / user’s manual. 
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This data entry screen is used to add new data /edit existing data for the TYPES.TPS 
database file. 

BROWSE – TRAINING LOCATION LOOKUP
This screen uses the principles that are described in the “Basics – Lookup Table” portion 
of this help file / user’s manual:

This browse screen serves two primary functions:

1. Add/edit/delete information that is stored in a dedicated database for the 
various locations that you utilize to conduct firearms training. 

2. Ensure data integrity is maintained – the primary purpose of a lookup table is to 
ensure that information is stored the same way every single time. For this 
application, this database ensures that the training location stores in the 
COURSES database is entered consistently.
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When you access a lookup database browse screen from a data entry screen, a button 
titled “Select” will be displayed directly underneath this listbox. When clicked, whatever 
listbox entry is currently highlighted will have a value from that lookup table’s database 
automatically inserted into the appropriate data entry field.

FORM – TRAINING LOCATION LOOKUP
This data entry form uses the principles that are described in the “Basics – Data Entry 
Screen” portion of this help file / user’s manual. 

This data entry screen is used to add new data /edit existing data for the LOCATION.TPS 
database file. 

EMAIL STUDENTS
Oftentimes you may have a need to send an email to former/current students to inform 
them of an upcoming firearms course that you plan on providing – CCWTrak has an easy 
way to generate that email with a few mouse clicks! 

1. Main Menu -> File ->Email Students OR click the toolbar button labeled ‘Email 
Students’
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2. A popup ‘Saved Queries’ window is displayed onscreen to select an existing 
query / create a new query condition / edit an existing query condition to suit 
this email’s needs:

                                          

[Note: if you press the ESCape key or click the CLOSE button on this window 
then every email address will be added to the email string that is sent to your 
email software, which might be the desired result]

3. After creating/modifying/selecting an existing query a command is sent from 
CCWTrak to your installed email client software (e.g. Microsoft Outlook; 
Thunderbird) to create a new email and send the string of emails (semi-colon 
delineated) to the Blind Carbon Copy (BCC) section of the new email:
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You would normally send the email to yourself: replace the text ‘_Replace Me’ with your 
email address, add a Subject Line to the email, and then either type into the email a 
meaningful, topic-oriented information or attach a file to the email. Done!

REPORTS MANAGER
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This screen is the interface to CCWTrak’s  embedded, full featured report authoring 
tool. Form letters, columnar reports, mailing labels, and mail merge forms can be 
created – best of all, the queries you’ve created for the CCWTrak databases are usable 
here too! 

Three tabs are displayed within this window. The first tab displays, using a ‘tree’ style 
list (that can be contracted/expanded – useful if you have built a LOT of reports and 
wish to quickly pare down the list) displays every report that has been saved to the 
..\REPORTS folder; the second and third tabs provide a useful, plain-English overview of 
this reporting tool.

The three buttons displayed on the right are used to create a new report, edit the 
currently highlighted report or permanently delete the highlighted report. 

The two bottom leftmost buttons are used to expand/contract the ‘tree’ list of reports – 
by default, the tree is displayed in the ‘expanded’ mode. 

The two bottom rightmost buttons are used to print the currently highlighted report 
and close this window.

It is important to note that creating/modifying/printing reports will NEVER alter/delete 
information that you have entered into the CCWTrak database files!

Please refer to its standalone manual/help file for  a full overview of how to 
create/modify reports.

Configuration
After installing the application to the desired location (e.g. a single PC on your business’ 
customer service counter, or onto your business’ file server):

1. Populate your lookup databases (aka: tables) first:
a. Main Menu -> File -> Lookup Table -> Courses You Teach
b. Main Menu -> File -> Lookup Table -> Firearm Calibers (*)
c. Main Menu -> File -> Lookup Table -> Firearm Type Codes (*)
d. Main Menu -> File -> Lookup Table -> Training Locations

(*) CCWTrak will ship with this database already pre-populated – you can 
modify its contents

2. Configure the CCWTrak application settings
Main Menu -> Configure Application Settings [note: when CCWTrak initializes it 
will automatically check if these settings have been configured or not. If at least 
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one of the entries is blank / the file is missing / the file is corrupt then this menu 
option is automatically executed for these settings to be manually entered]

      3. Configure Application Variables: This screen serves two purposes:
 The first two data entry fields are used for data entry screens and CCWTrak 

reports that you, the instructor, must submit to DPS.
 The second two data entry fields are used for data entry screens within 

CCWTrak – they will save a few keystrokes to enter information that is likely 
to never change (and reduce typographical mistakes).

Technical Information
CCWTrak’s space requirements are very small; here is a screen capture of all of the CCWTrak 
files:
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CCWTrak does not store data in any other locations on your computer (e.g. C:\Program Files) or 
within the Windows registry.  

A breakdown of the CCWTrak files:

Configuration Files

 CCWTrak.Ini - This is used to store application variables (e.g. the logo to use in 
report headers).

Databases

 Calibers.Tps – Lookup database that stores all possible handgun calibers
 Classes.Tps - Lookup database of class types that you teach
 Course.Tps – Stores each class that you’ve taught/will teach
 Location.Tps - Lookup database that stores all training locations you use
 Queries.Tps – Stores user-created queries
 Student.Tps – Stores all students that you’ve taught/will teach
 Types.Tps – Lookup database of the handgun types that a student can qualify 

with

Data Integrity Files

 CCW.Svb - Used to ensure that the application data files have the correct file 
structure

 CCW.Svi - Used to ensure that the application data files have the correct file 
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structure
Executable File

 CCWTrak.Exe - The application’s executable file

Help Files

 CCW.Chm - This is the application's help file
 Frbuser.Chm – CCWTrak’s help file for its embedded reporting tool

Runtime files

 ClaAsc.Dll - Ascii engine
 ClaDos.Dll - MsDos interface
 ClaFrb.Dll – Reporting engine 
 ClaOle.Dll - OLE runtime engine
 ClaRun.Dll - Runtime engine
 ClaTps.Dll - Topspeed database engine
 CTSQW11C110.Dll - Used by the Query Wizard 
 CwHHla.Dll - HTML Help interface
 vuLimiter.DLL - Low level functions
 WpdfControl04.Dll - Generate Adobe Acrobat compatible *.PDF files from the 

print preview screen
 WpdfControlWrapper - Generate Adobe Acrobat compatible *.PDF files from the 

print preview screen

CCWTrak also does not place much burden on your computer’s Central Processing Unit (CPU; 
aka: “brain”), computer until you nabu drive or memory. Here is a screen capture of CCWTrak 
running on a Windows 11:

Data Backup
Every company should draft/implement/execute a plan to archive their electronic data to 
external media, another company-owned computer system and/or the “Cloud” to protect their 
data from irretrievable loss due to power spikes, power outage and/or theft of the host 
computer system(s). CCWTrak stores its data within *.TPS files – at a minimum, your data 
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backup routine should archive the CCWTrak *.TPS files on a recurring basis. Should the CCWTrak 
software need to be reinstalled onto another company-owned computer system, the recovery 
process would require the reinstallation of the CCWTrak software (likely downloaded from the 
Software by Daughtry web site); enter your unique registration code(s) to fully activate the 
CCWTrak software application, and then recover the *.TPS files from your data archive into the 
CCWTrak installation folder.

Troubleshooting
Could not get write access to <> so trying read-only" error message
Example popup error message:

Reason: Database programs write information back to ‘database files’ – when the application 
starts it attempts to open the files in READ/WRITE mode. The folder that the database file(s) are 
stored inside of aren’t configured to allow the Windows user account that received this error to 
change data inside of this folder (and the popup error message is displayed). 

Tech-Speak: Windows folder permissions default to the MOST RESTRICTIVE to protect against 
malware. There are different ‘levels’ of permissions for every folder; listed below are the 
different levels listed in least to most restrictive: 

• Full Control 
• Modify 
• Read & Execute 
• List Folder Contents 
• Read-Write 

Database applications require WRITE / READ / LIST FOLDER CONTENTS / READ & EXECUTE to 
save data back to a database file. The “MODIFY” permission has all of these capabilities – this is 
the folder permission you should use for this database application.Fixing the Problem: Using 
Windows Explorer (e.g. double-left click the desktop icon named My Computer; alternatively, 
press the Windows START button, type in EXPLORER and press the OK button), navigate to the 
folder that the application is installed into (e.g. C:\Program Files (x86)\TimeTrak). Right click the 
mouse on the folder name (e.g. TimeTrak) to display a popup menu; select PROPERTIES from 
the list. A popup window is displayed onscreen; click the tab named SECURITY. At the top of that 
window portion is a list of Windows user groups/accounts; at the bottom is the list of security 
permissions assigned to that group/account (which changes when a different group/account 
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name is selected). Click the button named EDIT; a sub-window is displayed to add/remove 
permissions from a group/account. Click ADD; a sub-window is displayed; within the entry field 
type EVERYONE; click the CHECK NAMES button; click OK to return to the previous sub-window. 
The ‘Everyone’ user account is now highlighted (if it’s not highlighted, left click it once to select 
that entry). In the bottom half of the window click the checkbox in the ALLOW column for 
‘Modify’ – this will assign MODIFY permissions to the Everyone user group; the screen will 
resemble this: 

How to share a database app throughout your home/office network
Scenario:  Our database applications are multi-user capable, meaning your entire office can use 
this software at the same time.  While the application can be installed onto a file server, a more 
common scenario is one office computer has the software installed; the folder containing the 
software is SHARED and other machines in the office have a drive mapping created to that 
SHARED folder and a desktop shortcut placed on the other machines to start the program at the 
remote desk. 

Primary Machine:  Log onto the office computer that has the database application installed onto 
its internal hard drive. Start Windows Explorer and navigate to the folder that contains the 
database application). Right click the mouse on the folder name (e.g. TimeTrak) to display a 
popup menu; select PROPERTIES from the list. A popup window is displayed onscreen; click the 
tab named SHARING. Click the button named ADVANCED SHARING; a popup window is 
displayed. Click the ‘Share this folder’ checkbox so a checkmark is displayed inside it; the Share 
Name can be changed if desired (it defaults to the folder name). Click the PERMISSIONS button; 
select the Group/User account name ‘Everyone’ and then ensure checkmarks are displayed 
inside of the CHANGE and READ checkboxes in the ‘Allow’ column (as shown below, far right 
popup window):
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Click the OK button to close the ‘Permissions’ sub-folder. Click OK to close the ‘Advanced 
Sharing’ sub-window. Click the Close button to close the Properties window. This folder is now 
being shared by that computer on your office’s internal computer network.  The next step is 
visiting each workstation whose occupant needs to use this shared software application to (a) 
create a drive mapping to the share you just created and (b) create a desktop shortcut for the 
application.  DONE

How to create a drive mapping to an app on your home/office network
On a computer different than the one the database application was installed onto, have the 
employee log into their machine; start Windows Explorer.  For Windows 10 machines click the 
HOME button; click the EASY ACCESS button which will display a drop list menu – select MAP AS 
DRIVE:
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A popup window is displayed to assign a Drive Letter to a shared folder located elsewhere on 
your office network.  The drive letter can be any unassigned drive letter; use the default or 
select one from the droplist. Click the BROWSE button to select the workstation name that the 
database application is installed on (note: for this example, the workstation name is SCOTT- 
ALIENWARE); left click that workstation name to expand the list of shared folders. Left click once 
on the share name (for this example, the shared folder name is ‘TimeTrack’) and click OK:

When the OK button is clicked the network path (that you just selected via the popup menus) is 
automatically entered into the folder name entry field:

Click FINISH.  Drive letter X on this workstation is now mapped to the TimeTrak folder located on 
the Alienware computer in this office. Repeat this process for the other employees/computers 
in your office. DONE
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How to create a desktop shortcut to start a database application
PROLOGUE:  This instruction assumes that (a) the employee has logged onto their computer and 
(b) has already created a drive mapping to the database application located on a computer 
located elsewhere in the office.

1. Return to the Windows desktop by holding down the START menu button and then 
pressing the letter D 

2. Move the mouse cursor anywhere on the desktop that is unoccupied by an icon 
3. Right click the mouse 
4. From the popup menu select NEW, then SHORTCUT 
5. Click BROWSE 
6. Left click the entry titled ‘This PC’ 
7. Scroll down until you locate the drive letter that was mapped to the database 

application located elsewhere on the network; if you’ve been following this web site’s 
FAQ examples drive letter X is left clicked on once 

8. A list of files located in that remote folder are now displayed; scroll down until you see a 
filename with a .EXE file extension:

9. Click the OK button after selecting the correct .EXE file (for this example the 
TimeTrack.exe file is correct). The path to the executable file is inserted into the location 
entry field. Click NEXT 

10. You can either change the Shortcut’s Name or leave it to the filename (default). Click 
FINISH. 

11. The new desktop shortcut icon is now added:
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File creation error message appears whenever our application starts
Problem: After starting a Software by Daughtry software application, Windows displays a popup 
error box: 

Reason:  The software application is trying to create a new file or modify the contents of an 
existing file and can’t because the current Windows user account lacks sufficient Security 
Permissions inside of that folder to complete the task Solution:  Add the default Windows group 
“Everyone” to that network folder and assign it MODIFY Security Permissions Steps: Execute the 
following steps to resolve this Windows security permissions problem: 

1. Start Windows Explorer (click the START button, type in File Explorer, select that 
displayed option) 

2. Navigate to your C:\Program Files (x86) folder 
3. Right click the folder that contains the Software by Daughtry application (e.g. CCWTrak); 

click the Security tab: 
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4. Click the EDIT button: 
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5. Click the ADD button: 

6. Within the entry field (the cursor is already placed inside that box) type in the text 
everyone 

7. Click the CHECK NAMES button that is now active: 

8. When Windows locates the Everyone user account that text (that you typed into the 
entry field) is underlined 

9. Click the OK button to close the ‘Select Users or Groups’ window; the user group 
Everyone is now listed: 
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Notice the checkbox for ‘Modify’ for ‘Everyone’ is currently unchecked - this means that 
the Modify security permission is currently being denied within this folder for Windows 
user accounts that are a member of the Everyone user group. 

10. Left click the Everyone entry to select that Windows user group, then left-click the 
empty checkbox under Allow for the Modify line; your screen now has checkmarks 
under the ALLOW column for Modify, Read & Execute, List Folder Contents and Read:

11. Click OK to save the changes; click OK in the next window to close the Properties 
window 

12. Done
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Now, any Windows user account for this computer should be able to create/modify data 
files within this hard drive folder with no more error messages (as all Windows user 
accounts are automatically a member of the Everyone user group)

Support and Registration/Donation
1. Send us an email (scott@sdaughtry.com) that fully describes the problem(s) you’re 

experiencing and we will get back to you as soon as possible. It is prudent for you to 
fully back up this application’s folder (in full) as a precautionary pre-troubleshooting 
step.

2. This application is distributed as a TRIAL – upon our receipt of payment, you will receive 
(via email) a special file that converts the application from TRIAL mode to FULL mode – 
no more restrictions will apply to the operation of this application. The software will 
branded to you/your company. All information entered during the TRIAL period is fully 
accessible once unlocked from TRIAL mode to FULL mode. This application’s dedicated 
web page located on our company web site (http://www.sdaughtry.com) has the 
payment instructions should you decide to keep using this application past its TRIAL 
MODE limitations. 

mailto:scott@sdaughtry.com
http://www.sdaughtry.com
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